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This job aid is available online: 
• In the Public Folders: 

All Public Folders > Statewide > Connections > Build 15 

• On the CONNECTIONS Intranet site: 
DFA Intranet Site > OCFS Homepage > Connections > Desk and Job 
Aids  
The CONNECTIONS Intranet site also contains information about 
CONNECTIONS training. 

 
Note: New Help Desk  
The NYS Enterprise Help Desk is available to provide support and answer basic 
questions related to your equipment, or problems you’re having with the 
CONNECTIONS application. If they cannot solve your problem, they will record your 
information and forward it to others who can. 

When you call the Enterprise Help Desk with a problem, you will be given a ticket 
number to use for tracking your issue and its resolution. Keep a record of this number; 
you will need it for any follow-up conversations with the Enterprise Help Desk. 

The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The new 
telephone number is: 

1-800-NYS-1323 
(1-800-697-1323) 

 
 

Note: Any visible identifying data in this job aid is simulated.  
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Introduction 

This Job Aid provides information on the changes to CPS and Common Functions in 
CONNECTIONS that are being introduced with Build 15. In order to perform some of 
these new functions, new security attributes are required. Specific security attributes and 
other requirements are included in the applicable sections of this job aid. Contact your 
Security Coordinator if you have questions regarding your security access.  

Specifically, this job aid contains information on: 

• The introduction of two new capabilities, Person Unrelate and Remove Person, 
and changes applied to the existing Person Merge and Person Split functions. 
These enhancements will enable districts to make corrections on persons who 
were added incorrectly to the case.  

• The creation of new windows, including: 

⇒ Multiple Primary Address/Phone Maintenance window; and 

⇒ Assigned Workload (Filtered). 

• Enhancements to existing CONNECTIONS windows, including: 

⇒ System Identifier information (e.g., Case ID) added to the title bar for 
several windows to help workers keep track of the record they are 
viewing; 

⇒ New date columns added to the Event List that indicate when an event 
occurred and when the event was updated by the worker;  

⇒ New Race and Ethnicity fields that are designed to meet new federal 
reporting requirements; and 

⇒ Modifications to the Person Detail window to ease navigation to other 
windows that modify person information.  

• The creation of a new Rejection Task To-Do that will help workers view rejections 
comments and navigate directly to the appropriate window.   

• The introduction of Phonetic Address Search to the Person Search function. 

• Modifications to the Priority Closure window that include more space in the 
Comments field to record information. 

• New Alert notifying the Approver/Manager when a task or event was saved and 
submitted to anyone other than the Unit Approver. 

• The Change Case (Stage) Name window has been changed to Case (Stage) 
Name/CD window. This window has two new fields that will enable NYC workers 
to maintain community district information.  

• Updates to the CONNECTIONS Online Help system to support changes in this 
Build. 

 

CONNECTIONS - System Build 15 - CPS Job Aid  4/10/02 Page 3 



 

Changes to CPS Functions  

Person Unrelate and Remove Person  
Build 15 introduces new functions that will enable districts to make corrections on 
Persons who were added incorrectly to the case. These new functions are accessed 
from the Person List Options drop-down menu:  

• Person Unrelate provides workers with the ability to “unrelate” an individual who 
was related in error during the Intake stage.  

• Remove Person – Added in Error, removes an individual who was misrelated or 
added during Investigation or ARI Stages. This function can also be performed in 
FAD stages. 

 

Person Unrelate 

The Person Unrelate function is performed in an open Investigation stage from the 
Person List. The Person List can be accessed from the Task List, Case Search window, 
Case List or Staff To-Do List. 

When a Person Unrelate is performed, the misrelated person (and the information 
associated with the misrelated person), no longer appears in the Intake or other 
associated stages. A new person record with a new Person ID is created on the 
CONNECTIONS database using the information reported during the Intake.  

A new Unrelate event is created for the associated Investigation stage. The following 
event description provides the worker with both the misrelated Person ID (PID) and the 
new Person ID:  

“<PID> was unrelated from <PID>” 

 

A new Alert is also generated to all workers who are assigned to an open stage that 
involves the misrelated person. The following alert notifies the worker that a Person 
Unrelate occurred:  

“<Name> (<PID>) was unrelated from <Stage Name> (<Stage ID>).” 
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In order to perform a Person Unrelate, a worker must meet the following requirements: 

Security Attribute Needed Person Unrelate 

Additional Access Requirements 

• Have a role in the case 
or 

• Be a member of the worker’s 
hierarchy 

or 

• Have an additional security 
attribute of either “Access All in 
District” or “Access All Cases.” 

To Perform a Person Unrelate: 

1. Select the person on the Person List. 

2. Click the Options drop-down menu. 
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3. Select Person Unrelate. 
Please Note:  

⇒ If the person selected was not reported during Intake, the following 
message displays: 

“Person not in Intake. Cannot Unrelate. Choose Remove  
Person Added in Error.” 

⇒ When demographic information for the person about to be unrelated 
was changed after the date of the Intake, the information needs to be 
corrected prior to the Person Unrelate. The following message 
displays reminding the worker to make these changes:  

“Changes made to Person in this stage should be reset  
before continuing.” 

⇒ As long as the person about to be unrelated remains highlighted, the 
warning messages will display only once.  

⇒ If the misrelated person is associated with another CONNECTIONS 
event (e.g., Notice of Existence), the following message displays: 

“Events for this person in this stage will be invalidated! Continue?” 
 

Click on the OK button to continue. The following message displays: 

“Are you sure that you want to unrelated this person”? 

Click on the Yes button to complete the process or No to return to the 
Person List without performing the Person Unrelate.  

 

In order to maintain accurate data on the person, workers are responsible for correcting 
necessary demographic information (Name, DOB, Sex, Ethnicity, Religion, Race or 
Marital Status) prior to performing a Person Unrelate. For example, if the person’s age 
was changed from 45 to 35 years after the person was added to the stage, then the 
worker must restore the original information (age must be changed back to 45 years) 
before the Person Unrelate is performed. 

Performing an Unrelate changes a person’s role. If the person received a notice prior to 
the Unrelate, the local district should send out a new notice with the correct information. 
Notices should also be sent whenever a new subject or person over 18 is added to a 
stage. 

Once the Person Unrelate is complete, the Case List is refreshed and displays the 
correct person information. A “U” populates the SCH column, indicating that an unrelate 
has occurred. These changes will be reflected in the Person Data Report. Intake/IRI 
reports will display “U” in the REL field for a person that was unrelated. 
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Remove Person – Added in Error  

Workers can perform the Remove Person – Added in Error function in an open 
Investigation stage from the Person List. The Person List can be accessed from the 
Task List, Case Search window, Case List or Staff To-Do List. 

When the Remove Person – Added in Error function is performed, the misrelated 
person is removed from the stage. A new event is created for the associated 
Investigation stage. The following event description provides the worker with the Person 
ID (PID) that was removed from the stage: 

“<PID> was removed from stage” 
 

The following Alert is also generated to all workers who are assigned to an open stage 
that involves the removed person: 

“<Name> (<PID>) was removed from <Stage Name> (<Stage ID>).” 
 

In order to maintain accurate data on the person, workers are responsible for making 
necessary demographic (Name, DOB, Sex, Ethnicity, Religion, Race, or Marital Status) 
changes prior to performing the Remove Person-Added in Error. For example, if the 
person’s age was changed from 45 to 35 years after the person was added to the stage, 
then the worker must correct the age to restore the original information. If any of this 
demographic information has changed since the date the person was added to the 
stage, the following two messages display: 

“Changes made to Person in this stage should be reset before continuing.” 

Clicking OK displays the following message: 

“Are you sure you want to continue with the unrelate?” 

In order to perform a Remove Person – Added in Error, a worker must meet the 
following requirements: 

Security Attribute Needed Remove Person – Added in Error 

Additional Access Requirements 

• Have a role in the case 
or 

• Be a member of the worker’s 
hierarchy 

or 

• Have an additional security 
attribute of either “Access All in 
District” or “Access All Cases.”  
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To Perform the Remove Person – Added in Error: 

1. Select the person on the Person List. 

2. Click the Options drop-down menu. 

 
 

3. Select Remove Person – Added in Error. 
 

If the person is associated with another CONNECTIONS event (e.g., Notice of 
Existence), the following message displays: 

“Events for this person in this stage will be invalidated! Continue?” 
Click on the Yes button to continue or No to return to the Person List. If “Yes” was 

chosen, the following message displays: 
 

“Are you sure you want to remove the person Added in Error”? 
Click on the Yes button to Remove the Person or No to return to the Person List. 

Note: Workers will not be able to perform the Remove Person – Added in Error 
function if the person was reported in Intake or named in an allegation.  

Changing the Case or Stage Name 
Cases are named after the first principal added to the case in the first Intake. Each stage 
in the case is named after the first principal added to that stage. If performing the Person 
Unrelate or Remove Person - Added in Error function results in an incorrect Case or 
Stage Name, workers are expected to update the system with the correct name.  
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To Update the Case or Stage Name: 

1. Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays.  

2. Click on the stage that requires a name change. 

3. Click on the Options drop-down menu and select Case (Stage) Name… 
The Change Case Name window displays. 

4. Click on the drop-down arrow for the New Name field and select from the 
resulting list of principals in the case. 
You cannot enter a name here; you must select a name from the drop-down 
list. 

 
 

5. Click on the Save button. 
The Assigned Workload displays. The selected stage now reflects the new 
name. 

Person Reported in Error  
A new role, “Reported in Error,” has been created to address persons who were reported 
in error during the Intake stage. The assignment of this new role is performed in an open 
Investigation stage. 

Only the Primary worker, Secondary worker, case manager and those in the unit 
hierarchy of the Primary or Secondary worker can select this new role. Workers must 
also have the appropriate security, including the new security attribute, “Maintain 
Reported in Error.” 

In order to change a person’s role to Reported in Error, the following conditions must 
exist: 

• The person must have been reported during the Intake stage; 
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• The person cannot be associated with any substantiated allegations (the 
allegation details must be completed prior to changing the person’s role to 
Reported in Error); and  

• There must be at least one other allegation, which does not involve the person 
whose role is being changed to Reported in Error. 

 

Pre-existing Notification events (e.g., Notice of Existence) generated for this person will 
not prevent changing the person’s role to Reported in Error. The district is responsible 
for sending out manual letters notifying the person of the role change. Once the change 
is complete, the following notifications can no longer be generated for the person whose 
role was changed to Reported in Error: 

• Notice of Existence 

• Notice of Indication  

• IAB Notification letter, IAB Indicated letter, and IAB Unfounded letter  

 

To Change a Person’s Role to Reported in Error:  

1. Select the person from the Person List. 

2. Click on the Detail button. 
The Person Detail window displays. 

3. Click on the drop-down arrow for the Role field. 
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4. Select Reported in Error.  

5.  Click on the Save button. 
The following message displays:  
 
“Unsubstantiated/Undetermined allegations will be deleted. Continue?” 
 
If the person was not reported during the Intake, the following message 
displays: 
“Person not in Intake cannot change role to Reported in Error” 
 
If no other allegations are associated with another person, the following 
message displays: 
“A Subject and MA/AB child must remain.  Cannot change to Reported in 
Error.” 

 
The allegations associated with this person will be deleted when the change is complete. 
A recalculation of overall roles and determination occurs when a person’s role is 
changed to Reported in Error.  

Note: (NYC Only) If a High Priority (HP) Factor is calculated for the Intake stage due to 
this person’s role and changing the role of this person during the Investigation stage 
means the HP is no longer in effect, then the HP Factor would no longer populate the 
Assigned Workload when the HP Factors are recalculated. This type of report would still 
be considered High Priority because it was designated as High Priority at Intake. 

Changing a person’s role to Reported in Error changes how and where that person is 
listed in CONNECTIONS: 

• Once a person’s role has been changed to Reported in Error, XE will display in 
the Role column on the Person List for that person.  

• If a person’s only role in a case is Reported in Error, he/she will not display in the 
Case Composition window.  

• A person whose role has been changed to Reported in Error will return in the 
following searches:  

⇒ A Person Search (Toolbar and from within a case); 

⇒ Clearance Batch Searches with the request type of Request For 
Information (RFI) and Administrative Review (ADREV); and  

⇒ Online Clearance Searches.  
The person will not return if the Clearance request type is Clearance (CLRCE) 
and the person’s only role in the case is Reported in Error.  
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Maintain Primary Address and Phone 
Prior to Build 15, when workers updated an individual’s address and/or phone 
information, they navigated through multiple windows and were only able to update one 
person at a time. Build 15 introduces a new window called the Maintain Primary Address 
and Phone window. Rather than retyping the information for each person, workers are 
able to use this one window to add or modify the primary address/phone information for 
multiple persons in a stage. This new function only applies to the Investigation stage. 
This window can also be used to select the existing primary address/phone for persons 
newly added to a stage. 

Workers navigate to the Maintain Primary Address and Phone window by selecting the 
Maintain Primary Address Phone task on the Task List.  
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Address and Phone information can be maintained using one of the following two 
methods: 

I Manually Entering the New Address and/or Phone Information 

1. Record the new information in the fields at the top of the window. 

2. Click on the Validate button to perform a CODE-1 address validation. 
All addresses must be validated. If there is a discrepancy between the 
CODE-1 address and the address that was recorded, a message will 
display showing both addresses for comparison.  
Please Note: If a NYC address was entered and the CD was not 
retrieved, the following message displays 
 “Community District Could not be Populated”  
 

 

3. You must choose to either Accept or Reject the Code-1 Validated 
address. Click on the Accept button to replace the recorded address with 
the CODE-1 address; or click on the Reject button to use the recorded 
address.  
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4. To link this address to one or more individuals listed in the lower section, 
click on the box to the left of the individual(s) name. If you wish to select 
more than one individual, press and hold the Ctrl key while clicking on the 
box to the left of the name. 
Selected individuals will highlight. 

5. Click on the Save button. 
The following message displays: 
”Changes Have Been Saved” 

6. Click on the OK button. 
The Maintain Primary Address and Phone window refreshes and displays 
with the modifications. Workers can make any additional changes or click 
on the Cancel button to return to the Task List. 

Or 

 

II Linking an Individual to a Pre-existing Case Address  

1. Select one person from the list in the lower section of the window. 

2. Click with the right mouse button.  
A menu displays offering the following options:  

⇒ Use Primary Address;  

⇒ Use Primary Phone; and  

⇒ Use Both Address and Phone. 

  

3. Select an option from the menu. 
Once an option has been selected, the Address/Phone information 
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automatically displays in the appropriate fields. This information can be 
altered if it is not applicable to the person.  

4. If either Use Primary Address or Use Both Address and Phone is selected 
from the menu, click on the Validate button to perform a  
CODE-1 address validation. 
All addresses must be validated. 

5. To link this address to one or more individuals listed in the lower section, 
click on the box to the left of the individual(s) name. If you wish to select 
more than one individual, press and hold the Ctrl key while clicking on the 
box to the left of the name. 
Selected individuals will highlight.  

6. Click on the Save button. 
The following message displays: 
”Changes Have Been Saved” 

7. Click on the OK button. 
The Maintain Primary Address and Phone window refreshes and displays 
with the modifications. Workers can make any additional additional 
changes or click on the Cancel button to return to the Task List. 

  

Workers can exit the Multiple Primary Address/Phone Maintenance window without 
saving at any time by clicking on the Cancel button or selecting Cancel from the File 
drop-down menu. 

Moving Associated Stages During a Case Split  
When a case is split, an Intake stage is separated from the merged case. In specific 
incidences in the past, an Intake stage was separated (split) from the case and the 
associated Investigative stage remained in the original case. The associated 
Investigative stage did not move with the Intake stage during the nightly split batch run.  

Build 15 includes changes to this process. Now, when a worker splits an Intake stage 
from a case and progresses it prior to the nightly split batch run, the system will check to 
see if the stage is linked to any other stage. The system will now move all stages 
identified as belonging together during the split batch.  

 

Case Splits Involving Additional Information and Duplicate Reports 
Build 15 introduces a change that prevents Additional Information and Duplicate Reports 
from being split off to a single stage case.  

All Additional Information and Duplicate Reports are merged to open cases when they 
are assigned by the SCR. On occasion, cases that appeared open in CONNECTIONS 
were actually closed, resulting in the SCR merging new Additional Information and 
Duplicate reports to cases that were no longer active. Some workers would either split 
the Additional Information or Duplicate Report from the case or void the pending merge 
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to undo the SCR action. This resulted in a single closed Additional Information or 
Duplicate stage in a closed case, to be expunged in the future. 

The Priority Closure window has been modified to prevent the closure of an Additional 
Information or Duplicate stage if it is the only stage in a case. If a worker attempts to split 
an Additional Information or Duplicate stage that is the only stage in a case, the 
following message displays: 

“Cannot close Add Info or Dup if only stage in case. Merge or change type.” 

 

Closure is also prevented if there is a pending merge. If a worker attempts to split an 
Additional Information or Duplicate stage that is pending merge, the following message 
displays: 

“Add Info or Dup cannot be closed. It is involved in a pending merge.” 

 

The Priority Closure window now provides workers with: 

• More space in the Comments field in the Priority Closure window to record 
information; and 

• The ability to navigate from the event (on the Event List) generated by the Priority 
Closure window. While in browse mode, workers can view the comments that 
were recorded during closure.  
 

 
 

Workers are still able to perform a case split when the Additional Information or 
Duplicate stage was incorrectly merged. The Additional Information or Duplicate stage 
re-opens during the Case Split Batch and display on the worker’s Assigned Workload. 
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Workers can merge the stage to the correct case or change the Duplicate to Initial (if 
appropriate). Workers should initiate a merge from the case that the Additional 
Information or Duplicate will be merged to. Additional Information, Duplicate, and 
Subsequent stages should always be the “From Case” in a case Merge. 

 

CAPTA Changes 
Modifications have been made to CONNECTIONS to address statutory changes for 
Unfounded Investigations with an Intake date after 2/12/96 (post-Elisa). These 
Unfounded Investigations will have an expungement date set for 10 years after the date 
of Intake.   

 

CPS Notification Letters 
The format and content for the CPS notification letters (the Notice of Existence and 
Notice of Indication) have been updated to reflect the following: 

• All references to DSS have been replaced with OCFS. 

• The SCR address has been corrected. 

• The wording in the Notice of Indication has been modified so that it applies to 
both confirmed and non-confirmed subjects. The context of the Notice is based 
on the person’s role.  

• The heading section has been increased to accommodate the letterhead for 
individual counties. 
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Changes to Common Functions 

Person Merge and Person Split 

Build 15 offers several enhancements to the Person Merge and Person Split 
functionality.  

Person Merge 

With the implementation of Build 15, once a person merge has been completed, the 
Person Forward (the person who is carried forward to further stages) replaces the 
Person Closed (the person who is merged) in all non-intake stages (open and closed), 
events and allegations.  

Another enhancement introduced with Build 15 is the creation of the Person Forward 
Selection window. This new window allows workers to select specific person information 
to be applied to the Person Forward.  Clicking on the Merge button on the Person/ 
Merge Split window opens the Person Forward Selection window rather than just 
performing the merge.  
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• The following information displays on the Person Forward Selection window for 
both the Person Forward and the Person Closed:  

⇒ Full Primary Name (First, Middle, Last Suffix); 

⇒ Sex; 

⇒ Ethnicity; 

⇒ Race;  

⇒ Marital Status; 

⇒ DOB (including Approximate indicator);  

⇒ DOD (including Approximate indicator and Reason); 

⇒ Primary Address; and 

⇒ Primary Phone. 
 

• Information can be selected from either person by clicking on the corresponding 
radio button. The type of information you select, and which person you select it 
from, has an effect on the information that is retained for the Person Forward. 

• If you are selecting information (e.g., Name) from the Person Forward, the 
primary information for the Person Closed is end-dated and copied to the Person 
Forward. 

• If you are selecting information from the Person Closed, the primary information 
for the Person Forward is end-dated and the information from the Person Closed 
is copied as the primary record. 

• Some person information is not part of the selection process on the Person 
Forward Selection window. For example, starting with Build 15, information 
regarding a person’s Occupation and Living Arrangement will no longer be 
collected. The Occupation and Living Arrangement fields have been removed 
from the Person Detail window. However, if this information was recorded for a 
person prior to Build 15, it will still be maintained in the database. When a Person 
Merge is complete, the Person Forward’s information is retained for Occupation 
and Living Arrangement. This information also displays in the Person Data 
Report. 

• Valid Person Identifiers, Person Detail FA Home Information, Language and 
Religion are also retained from the Person Forward, unless the field is blank. If 
the Person Forward does not have this information, the information from the 
Person Closed is copied to the Person Forward. 

  

Changes resulting from a merge or spilt are reflected in other windows.  

• The M column on the Person List has been changed to M/S. This column 
continues to indicate that a person has been involved in a merge or split.  
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• A new column, M/S, has been added the Case Composition window to indicate 
when a person has been involved in a merge or split.  

• Once a merge has been completed, the Person Closed will no longer display in 
the Case Composition window.  

• When 2 people in the same INV stage (open or closed) are merged, duplicate 
allegations are deleted. 

An initial data fix will also be implemented with Build 15 to update information in the 
database. This data fix will be run only once and will update the Person Closed with the 
Person Forward for all non-intake closed stages, allegations and events for Person 
Merges that occurred prior to Build 15.  

In order to perform a Person Merge/Split, a worker must meet the following 
requirements: 

Security Attribute Needed Merge/Split 

Additional Access Requirements 

• Have a role in the case 
or 

• Be a member of the worker’s 
hierarchy 

or 

• Have an additional security 
attribute of either “Access All in 
District” or “Access All Cases.” 

• If the stage is open, have an 
additional security attribute of “Unit 
Summary Access” or “All Unit 
Summary” when the worker is in 
the same unit as a worker with a 
role in the case.  

 

Person Split 

A Person Split is performed when the records for two separate persons were 
accidentally merged (combined) into one. Performing a Person Split reactivates the 
Person ID for the Person Closed (the person who was erroneously merged into the other 
person), thereby restoring the Person Closed as a separate individual to the database. 
The records for these individuals must be carefully restored for each stage, allegation, 
and event.  

Workers can use the Maintain Person function to update the database when the 
investigations are open. In addition, workers can remove the Person Forward by 
performing the Remove Person Added in Error function. 

If the Investigation stage is closed, workers can use a new data fix that is being 
introduced with Build 15. This data fix will be initiated through the Enterprise Helpdesk 
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on request by the local district. Workers will use this process to update all demographic 
information and return the Person Closed to all appropriate non-intake stages, events 
and allegations that existed prior to the merge.  

After a Person Split is performed, the Person Closed’s information can be accessed 
through the Person Detail window when conducting a Person Search. Information that 
existed prior to the merge for the Person Closed is restored for that stage.  

Approvals and Events 
Prior to Build 15, if a worker’s submission of work to a supervisor was rejected, the 
rejection reason could not be viewed directly from the Task List. Workers could not 
navigate directly from the rejection To-Do to the event that needed to be corrected. 
Workers had to navigate to the Approval Status window to find the information.  

Build 15 introduces a new Rejection Task To-Do that will help workers view the rejection 
reasons and navigate directly to the appropriate event related window. This new Task 
To-Do replaces the Alert To-Do, formerly used to notify the worker there was a rejection.  

 
 

Once a rejection has been completed by the approver, the Rejection Task To-Do will 
display on the worker’s Staff To-Do List and on the Case To-Do List. This provides 
workers with the ability to view the rejection reason from the Staff To-Do List or Case To-
Do List.  
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NOTE: The status of the original Task To-Do for the 7-Day Safety Assessment that 
reminds the worker to submit the work to their supervisor will also change to 
“REJT.” To view the new Rejection To-Do, please select the Task To-Do with the 
Description “CPS 7-Day Safety Assessment – Rejection Logged.” 

To View the Rejection Reason: 

1. Select the Rejection To-Do from either the Staff To-Do List or Case To-Do 
List. 

2. Click on the Detail button.  
The To-Do Detail window displays. The Comments recorded by the 
supervisor display in the Comments box. 
 

 
 

Workers are able to navigate to the appropriate event-related window from the Rejection 
To-Do. 
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To Navigate to the Event from the Rejection Task: 

1. Select the Rejection Task from the To-Do List. 

2. Click on the Navigate button. 
The appropriate event related window displays. 

3. Record necessary revisions.  

4. Click on the File drop-down menu and select Save and Submit. 
 

A new event status, “REJT” has been added to the Event List. “REJT” displays in the 
Status column on the Event List if the approver has rejected the event. When the worker 
re-submits the task, the event status changes from “REJT” to “PEND.” Once the event 
has been approved, the Status column displays “APRV.” The Rejection Task To-Do is 
removed from the To-Do List after the work is re-submitted. 

Save and Stay option for the Investigation Conclusion window 
Build 15 provides workers with the ability to select Save and Stay from the File drop-
down menu when recording information on the CPS or IAB Investigation Conclusion 
windows. This benefits workers by allowing them to save the information without having 
to close the window. 

New Event Dates added to Event List 
Build 15 has added two new dates for each Event on the Event List. These dates 
provide clarification to users while viewing case events. 
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The Date Event Occurred displays in the Event Date column. This represents the date 
that an event was completed, as recorded on the specific window or during the events 
evaluation (e.g., the Date Event Occurred for the Safety Assessment Event is the date 
that was recorded in the Date field on the Safety Assessment window). If no date was 
recorded, the Event Date column for that event will remain blank. 

The System Transactions Date displays in the TX Date column. This represents the date 
an event is updated by the worker using one of the Save functions (e.g., Save, Save and 
Submit, Save and Close, and Save and Stay) on the specific event’s window.  

Some events are generated as complete and do not require a save (e.g., Assignments 
and Notification letters). Both the Event Date and the TX date for these types of events 
correspond to the date the event was created. 

Phonetic Address Search 
Prior to Build 15, address searches were exact and only returned results that matched 
the search criteria character for character and space for space. Build 15 introduces a 
new method of searching for addresses in CONNECTIONS that will be more effective.  

A third option, Phonetic Address, has been added to the Search Type drop-down list 
on the Person Search window with Build 15. With the implementation of Phonetic 
Address Search, address-searching capabilities are expanded. This new search type 
increases the pool of potential matches by including search results on partial address 
information. It also has an effect on the way results are scored and displayed, the way 
data is identified and the way you enter data used in a search. 

When a worker selects the Phonetic Address Search type, the Street Line 1 field 
highlights and becomes a required field. All non-address fields (e.g., First Name, DOB) 
become disabled.  
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The resulting candidate pool is based on and created solely using the phonetic similarity 
of the Street Line 1 portion of the candidate’s address to the Street Line 1 portion of the 
search address.  

Within this result pool, all address criteria (e.g., Street 
Line 1, City, State) is used to score (rank) the 
candidates, with Street Line 1 receiving the most weight. 
The closer the result candidate’s Street Line 1 is to the 
Street Line 1 search criteria, the higher the score. 
Workers who enter just the name of the street (e.g., 
Willow) in the Street Line 1 field, without the house 
number or suffix (e.g., Avenue) receive results on all 
matches that are phonetically similar. Resulting 
addresses containing street numbers or a suffix that are 
phonetically similar to the searched for street name will 
display lower on the list. If the name of the city was used 
in the search, addresses that contain “Willow” for that 
city will receive a higher score and display higher on the result list.  

 

A Phonetic Address Search using the 
following criteria: 

Produces the following Result List:  

Street Line 1 City Result List 

Willow Apple City • Willow, Apple City 

• Willow, Beachnut City 

• Willow, Chippertown  

• 5 Willow, Apple City 

• 5 Willow, Beachnut City 

• 63 Willow, Apple City  
The result list in this example 
would continue with all matches 
that are phonetically similar to the 
Street Line 1 search criteria.  

 

If you are not absolutely sure 
of the house number or the 

suffix, it is best not to use this 
information as part of the 

search criteria. Using either 
of these narrows the result 
pool and could eliminate 

potential matches. 
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Information that is entered in the other address fields influences where on the result list 
the candidate displays. For example, candidates who match the Street Line 1 
information (Willow) and the City (Chippertown) receive a higher score than candidates 
who match the Street Line 1 but do not match the city.  

Workers who include the number with the name (e.g., 5 Willow) receive results on all 
matches with that number and street name. In some instances, a number or street name 
that is phonetically similar will also return in the search. 

 

A Phonetic Address Search using the 
following criteria: 

Produces the following Result List:  

Street Line 1 City Result List 

5 Willow Apple City • 5 Willow, Apple City 

• 5 Willow, Beachnut City 

• 5 Willson, Beachnut City 

• 5 Willout, Chippertown 
Candidates on the result list in 
this example would all have “5” in 
Street Line 1. House number 
greatly influences the result pool. 

 

When seeking a large result pool, try not to limit the search results by entering any data 
that would exclude possible results.  

To Perform a Phonetic Address Search 

5. Click on the Search Type drop-down menu on the Person Search window. 
(Note: The Person Search window continues to open defaulted to the 
Phonetic Name search type.) 

6. Select Phonetic Address Search.  

7. Enter the street name in the Street Line 1 field. 

8. Enter other known information in the remaining address fields (e.g., City, 
County). 

9. Click on the Search button.  
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Reviewing the Results on the Person Search List 

 

Be sure to review the entire 
list of results for possible 

matches. Street addresses 
(e.g., Willow, 5 Willow, 18 
Willow) from the same City 
will not score the same and 
may fall lower on the result 

list. Use the scroll bar to 
proceed through the list. 

• If results exist, the Person Search List title bar 
displays the message “Phonetic Address 
Results Returned.” 

• If no results exist, this title bar displays the 
message “No Results Returned.” 

• The Match column displays “ADDR,” 
indicating that a Phonetic Address Search 
was performed. 

• When the page-down button is enabled, there 
are more results on the list. Click on the page-
down button to advance to these results.  

 
In the following example, a Phonetic Address Search was performed using “Willow” in 
the Street 1 field, “Chippertown” in the City field, “NY” in the State field and “Ulster” in 
the County field.  

 

 
The result list in this example would continue with all matches that are phonetically 
similar to the Street Line 1 search criteria. Notice the page-down button in the lower right 
corner is enabled, indicating that there are more results.  

If the house number “5” was added to Willow in the Street 1 field search criteria in this 
example, then the candidates in the result pool would have “5 Willow” or a phonetically 
similar street in the address field. House number greatly influences the result pool. 



 

Race and Ethnicity Fields 
In order to capture a more accurate representation of an individual’s race and ethnicity, 
CONNECTIONS has made several modifications. These changes meet new federal 
standards that require the ability to collect multiple races for an individual and redefine 
the ethnicity categories. Ethnicity, Hispanic or Latino Origin and Race can be captured 
and displayed for individuals on the Person Detail, Call Person Detail and Home 
Demographics windows. 

 
 

The Ethnicity drop-down list has two options, Hispanic or Latino and Non-Hispanic or 
Latino. A third option, Not Reported, is available for both the Race and Ethnicity fields 
during the Intake stage. Race and Ethnicity are required fields on the Call Person Detail 
during an Intake stage.  

When Hispanic or Latino is selected, the Hispanic or Latino multi-select list box 
becomes enabled. One or more selections can be made from this list. One or more 
selections can also be made using the Race multi-select list box.  

Ethnicity, Hispanic or Latino Origin and Race information displays in several windows in 
CONNECTIONS. On the Call Person List, Case Composition window, the Ethnicity 
column displays ethnicity as a combination of Ethnicity and Hispanic origin (e.g., 
Hispanic or Latino – South American or Non Hispanic or Latino). If more than one 
origin has been selected from the Hispanic or Latino multi-select list box, the Ethnicity 
column displays Hispanic or Latino – Multiple. The Race column displays an 
individual’s race if one race was recorded. If more than one race was recorded, Multiple 
displays in the Race column. 
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The Person Search window provides a Race drop-down box that allows workers to 
select race. The Person Search List displays an individual’s race (if race was recorded). 
If more than one race was recorded, Multiple displays in the Race column.  

The Incoming Person Detail window displays one of the following in the Ethnicity drop-
down box: Hispanic or Latino; Non-Hispanic or Latino; or Not Reported. If Hispanic 
or Latino displays, then the Hispanic or Latino Origin multi-select list box displays. 
One or more selections may display. Race displays in the Race multi-select list box. 
These fields are protected.  

The Person Data Report displays ethnicity as a combination of Ethnicity and Hispanic 
origin. Changes to race or ethnicity will be tracked in this report. 

A radio button has been included for both the Race and Ethnicity fields on the Person 
Forward Selection window. This allows workers to select the information that will be 
passed on to the Person Forward. 

Ethnicity information that existed prior to Build 15 is being converted as part of the Build. 
All persons previously listed as “Unknown” and “Unable to Determine” in the Ethnicity 
field will be converted to “Not Reported” in the new Race and Ethnicity fields. Workers 
should review the conversions that were applied to the persons on their workload and 
update this information with any additional values that may be appropriate.  

Updates to the CONNECTIONS Online Help System 
Build 15 continues the development of the CONNECTIONS Online Help system. Online 
Help has been updated to reflect enhancements made to the system with Build 15. 
These enhancements include new and modified windows and fields, and changes to 
casework recording procedures.  
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Canceling Assignments 
A new window, List Assignments Made, has been created to provide workers and 
supervisors with the ability to reverse an assignment that was made in error. This 
applies to assignments made by the local district or agency only, and does not apply to 
intakes assigned by the SCR. 

 
 

The List Assignments Made window only displays assignments that have not been 
accessed by the assigned worker. Each assignment for a stage (Primary, Secondary) 
has its own row on the List Assignments Made window. An assignment is considered 
“accessed” when the assigned worker selects an option from the Options drop-down 
menu or clicks on the Tasks… button. If all of the assignments have been accessed, the 
List Assignments Made window will not open and the following message displays: 

“No Assignments to Retrieve. All Assignments Retrieved by Assigned Worker.” 
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To Cancel an Assignment from the Assigned Workload:  

1. Click on the Options drop-down menu and select List Assignments Made 
The List Assignments Made window displays. 
 

 

2. Select the assignment (stage) you wish to retract. 
If you select the Primary worker’s assignment when a stage has more than 
one assignment, you will have the assignment “rights” of the primary worker.  

3. Click on the Assign button. 
The Assign window displays. 

4. Reassign the stage to the correct worker. 

5. Click on the Save button. 
A final check is performed by the system to see if the stage was accessed during the 
canceling assignment process. If the stage was accessed, the worker receives a 
message notifying that the save will not be completed. The List Assignments Made 
window refreshes after an assignment has been successfully (or unsuccessfully) 
reassigned from the Assign window.  

If the original assigned worker attempts to access the stage after it’s been re-assigned, 
they will receive a message stating “Stage has been reassigned. Window will be 
refreshed.”  

Maintain Historical Jurisdiction  
Prior to Build 15, Local Districts had jurisdictional access to a case if a worker from their 
district was either: 

• Assigned to an open stage; or  

• Assigned to the stage when the stage was closed.  
Local Districts lost jurisdictional access if the open stage was transferred to another 
District.  

Build 15 expands this definition to provide local districts and agencies with jurisdictional 
access to a case when a worker from their district or agency either: 

• Is assigned to an open stage; or  

• Was ever assigned to a stage in the case.  
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In order to access a case based on jurisdiction, workers must have the “Access All in 
Jurisdiction” security attribute. Workers navigating from the Case List are able to view 
the Case Composition window, Case Summary window and the Event List. Additional 
security attributes are necessary to access details of sensitive cases and CPS 
investigations.  

 

New Alert for Unit Approver 
Build 15 introduces a new alert that is issued to the Unit Approver if the worker Save and 
Submits a task or event to anyone other than the Unit Approver.  

 
When the worker saves the To-Do Detail window, the alert is generated and displays on 
the Unit Approver’s Staff To-Do List. The alert provides the event type, Stage ID, name 
of the worker submitting the event and the name of the worker to whom the event was 
submitted for approval. The alert also includes a description to the Unit Approver. 

System Identifiers 
System identifiers have been added to the title bar of several CONNECTIONS windows. 
System Identifiers include Person Name, Stage Name, Resource Name, Case Name, 
Stage ID, Resource ID and Case ID. Adding identifiers to the title bar helps workers 
keep track of the record they are viewing. The navigational path followed by a worker 
determines which identifiers display.   

For example, when you navigate to the Event List from the Case To-Do List, the title bar 
on the Event List displays the Case Name and Case ID. When you navigate to the Event 
List from your Assigned Workload, the Stage Name, Stage ID and Case ID display in the 
Event List title bar.  
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Workers who navigate to the Case List from the Call Person List, Person Search, Person 
Detail, Person List or Person Detail windows will see the Person Name and Person ID 
displayed on the Case List title bar.  

When navigating to the To-Do Detail window from the Call Summary, Investigation 
Conclusion or Safety Assessment windows, the Case ID and Stage ID will display in the 
title bar for the To-Do Detail window.  

Assigned Workload Filter 
A new window called Workload Filtering has been created to make it easier to navigate 
through larger workloads. This window allows workers to filter their Assigned Workload 
by using one of the following three fields: 

• Stage ID;  

• Case ID; and  

• Match Retrieval by Stage Name.  

Workers using the Match Retrieved by Stage Name field must enter a minimum of two 
characters of the stage name in the field. 

 
Workers navigate to this new window by selecting the new Workload Filter command 
from the Options drop-down menu on the Assigned Workload.  

 
When an Assigned Workload has been filtered, the title bar will display Assigned 
Workload (Filtered).  
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Person Navigation 
The Options drop-down menu on the Person Detail window has been modified to ease 
worker’s navigation to other windows when modifying or adding certain person 
information. These four new options include:  

• AKA Name List/Detail; 

• Person Identifiers; 

• Person Events; and  

• Case List. 

AKA Name List/Detail and Person Identifiers were added to help workers navigate 
directly to the AKA Name List/Detail and Person Identifiers windows to modify and add 
person information. Person Events and Case List were previously named View Person 
Events and View Case List and were listed on the View Options drop-down menu. The 
View Options menu has been removed from the Person Detail window.  

A new Reports drop-down menu has been added to the Person Detail window. This 
menu lists the 30-Day Fatality Summary Report and the 24-Hour Fatality Summary 
Report. Those reports were previously listed in the Options drop-down menu. 

 

Maintain Address/Community District (NYC only) 
Community District (CD) information is now maintained for each individual with a New 
York City address and for New York City stages (CPS and FAD). CD’s are maintained 
for addresses during Intake, Investigation, ARI and FAD stages. New York City workers 
(including New York City voluntary agency workers) can view the new CD column from 
their Assigned Workload. All New York City workers and New York City Regional Office 
staff can view the CD in the Case Summary window.  

 
The CD of the active, primary address of the Mother is associated to the Intake Stage.  If 
there is no active, primary address for the Mother, the CD of the primary address of the 
Foster Mother is be used. In all other cases, the stage CD will be blank. CDs for 
individuals are two characters in length. The CD for a stage is three characters in length. 
The first character represents the county (B, K, Q, M or R) and the last two characters 
are numeric. 

The CD of the Intake stage is passed to the Investigation stage during stage 
progression. A New York City primary worker will not be able to stage progress an Intake 
unless a CD has been associated with the stage, (this does not apply if New York City 
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only has secondary responsibility). A New York City worker with the appropriate security 
can enter a CD or modify an existing CD in the New CD field. If New York City only has 
a secondary assignment, the secondary worker will be able to update the stage ID. 

 
The Change Case (Stage) Name window has been changed to Case (Stage) Name/CD 
window and includes two new fields: Current CD and New CD. The New CD field is 
enabled when a New York City worker accesses the Case (Stage) Name/CD window 
from the Assigned Workload and the stage is either an open Intake or open 
Investigation. Entering the first letter in the New CD field displays the appropriate section 
of the list for the worker to select the applicable CD. Changing the CD for one stage in a 
case does not change the CDs associated with other stages in the case. Only the CD for 
the corresponding stage is updated.  

A CD is automatically associated with an address when it is new or has been modified.  

Previously entered New York City addresses that are valid and active will be updated to 
include a CD.  
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